COGNEX

SAP Fiori Mobile (v2.1.x)

Introduction

What are hybrid mobile apps?

Hybrid mobile apps are web applications wrapped up their own browser which can run on any of the mobile platforms (Android, iOS, Windows
etc.). The big advantage of a hybrid app is that it has a single code base, whereas a native app must be re-written for each platform.

Apache Cordova is an open-source framework for developing hybrid apps. To use native features (beyond those already available via hmtl5,)
apps can make use of plugins. These plugins handle the platform-specific code and are available for single or multiple platforms. Plugins are
available to access the GPS, accelerometer or camera, for example.

SAP have written their own plugins, branded as Kapsel, to handle things like logon and offline OData. These bring an enterprise flavour to
hybrid apps.

What is Fiori Mobile?

Until recently SAP’s recommended approach was to use the Hybrid Application Toolkit (or HAT) in order to build hybrid apps. The app build
took place on the developer’'s PC or Mac. The HAT gained a reputation for being tricky to set up and that hindered the use of hybrid apps
within the SAP ecosystem.

Fiori Mobile has at its core a cloud-build service, so there is no need to install the HAT. We can trigger the build from Web IDE. We specify
the (already deployed) Fiori app(s) that we want to package and after a few minutes we can download the .apk (for Android) and .ipa (for iOS)
files ready to be installed on mobile devices.

Does it work?

The cloud build service works well. It typically build for both platforms in about 8 minutes without issueas. There have only been a couple of
occasions when builds failed due to technical problems.

There are some facets to the technology which don'’t feel mature yet. One area is the offline OData features. When using Fiori Mobile things
work differently to the more conventional hybrid and native apps. One example would be the destinations, because Fiori Mobile apps use a
generated destination which reference the SAP Cloud Platform (CP) portal service.

My point is not that offline OData seems immature, rather that the offline features can be tricky when used with Fiori Mobile apps. We are still
receiving assistance from SAP to get the offline features of our app optimised. This is a shame, because shared data and the handling of delta
requests, for example, are two features which justify the ‘middleware’ approach to offline that SAP have taken.

Authentication has also been a challenge. On a previous project | used the Fiori Client in conjunction with SAP Cloud Identity (now officially
SAP Cloud Platform Identity Authentication). The Fiori Client stored the username and password on the device so that the user didn’t need to
enter them every time their session timed out. We haven'’t achieved that yet with our Fiori Mobile app.

Account and Services

If you have production account browse on HCP Cockpit and log in. If you use trial account log in here

As we said before there is two ways to build SAP Fiori mobile application:

1. Using Fiori Mobile Service. Note that this service have been discontinued from March 31, 2018. Strategic features available in the
mobile service for SAP Fiori have been incorporated into SAP Cloud Platform mobile service for development and operations. However
you can use this service if you have old account that already has enabled that service. Using this service require two other services to be
enabled: Portal Service and SAP Web IDE Full-Stack Service.
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SAP Cloud Platform Cockpit

Overview

Applications Internet of Things

¥ Remote Data Sync

3 Synchronize data between remote
databases and a cloud SAP HANA

Services

Solutions

SAP HANA / SAP ASE

database.
Connectivity
Security Mobile
Repositories ¥: Mobile Services, preview
Usage Analytics Enabled
Run integration and regression
Members g tests and explore new mobile
features. NOT FOR PRODUCTIVE
USE.

Platform Roles

Runtimes & Containers

¥ HTMLS Applications

C\ Develop and run HTMLS
lsJ

applications in a cloud
environment.

User Experience /

¥E: Portal

Create role based, multi-channel
(:ﬁ} sites to access business apps and
content.

(?) Useful Links

¥: Remote Data Sync

¥ Synchronize data between remote
databases and a cloud SAP HANA

Services

Solutions

SAP HAMA [ SAP ASE database.

Connectivity

Security Mobile

Repositories ¥ Mobile Services, preview ¥ SAP Fiori Mobile

Usage Analytics Enabled Enabled

Run integration and regression Optimize, build, manage, and
Members Q tests and explore new mobile menitor SAP Fiori apps on mobile
. features. NOT FOR PRODUCTIVE devices.

USE.

Platform Roles

e
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B Senvices All: 24

= Solutions

SAP HANA / SAP ASE Data Management

Connectivity ¥ SAP ASE

Security Enabled

Create and consume SAP ASE
Repositories g databases.

Usage Analytics

Members
Data Privacy & Security

AE D ¥ Authorization & Trust Managem...

g Manage application authorizations
8 and trusted connections to identity
providers.

Developer Experience

 Git Service

Store and version source code in
Git repositories.

Services

Solutions Mobile

¥ Mobile Services, consumers

SAP HANA/ SAP ASE Build and run mobile apps for B2C

Virtual Machines

use cases.

Connectivity

Enhanced Disaster Recovery

Create Fiori Launchpad

¥ SAP HANA

Create and consume SAP HANA
databases.

¥ Keystore Service

Manage cryptographic keys and
certificates.

¥ Java Debugging

= Debug your Java application even
,-O-. through networks with high latency.
™M

¥ Mobile Services, preview

Run integration and regression tests
and explore new mobile features.
¥ NOT FOR PRODUCTIVE USE.

¥ OQAuth 2.0

Protect applications and APIs with
OAuth 2.0.

~

¥ SAP Web IDE Full-Stack

Create and extend SAP full-stack

@ applications for browsers and
mobile devices.

2. Using HAT (Hybrid Application Toolkit) extension in SAP Web IDE Full-Stack Service. Using this extension require Mobile Services to
be enabled.

e

¥ Mobile Services, users
Enabled

Build and run mobile apps for B2E
Q and B2B use cases.

If we use SAP Fori Mobile Service to build mobile application first we need to create and publish site where application will be deployed.

Otherwise if we use HAT skip this step and continue with Create Fiori Project

Go to Portal Service and create new Site Directory
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Home

Site Directory
Site Directory /

Services and Tools

Usage Analytics

A popup will be displayed. Enter your Site Name, choose SAP Fiori Launchpad as Template Source and click Create

Create Site ®

#Site Name | cmbSDKTestSite

Available Site Templates
P Search Q

Template Source | All v

Starter Site Basic Layout Set Admin Site SAP Fiori Launchpad

Create  Close

Following this you will be redirected to SAP Fiori Configuration Cockpit. Close the tab and go back to Admin Space for Portal Service.

Now we need to Publish this Site and Set as default.
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Y Home

Site Directory

% Site Directory

cmbSDKTestSite
Offline 11.6.2019 15:40

¥ Senices and Tools

Al Usage Analytics

A site template that uses SAP Fiori design elements. This
template is provided by SAP.

Publish

Duplicate

Export

Delete

5/36



COGNEX

A Home

Site Directory

Site Directory

cmbSDKTestSite
Published 11.6.2019 15:42

ﬂfj Senvices and Tools

Nl Usage Analytics

Asite template that uses SAP Fiori design elements. This
template is provided by SAP.

[sites?siteld=4f07ed14-db43-4efd-96b3-897c52f41414
Edit ~

Take Offline

Set as default

Duplicate

Export

Create Fiori Project

Once we create and publish cmbSDKTestSite we can create our Fiori project (if we use Fiori Mobile Service to build mobile application,
otherwise if we use HAT we don't need to publish site on Launchpad and creating Fiori project will be our first step).

Go to Services tab again, open SAP Web IDE Full-Stack service, and click on Go to Service
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& Service: SAP Web IDE Full-Stack - Overview

Service Description

With SAP Cloud Platform Web IDE Full-Stack, you can easily develop, test, bu
grade apps for business users. Create applications rapidly and deliver an outs!
or build SAP Fiori apps, create new SaaS solutions, extend SAP S/I4HANA clov
and build loT apps for SAP Leonardo, using the Ul development toolkit for HT

the SAP HAMA toolset, and Java programming language and technologies. Int
Platform, such as SAP Fiori Cloud apps, Git integration, mobile services, loT si

Take Action
Configure Service
Logs

Go to Service

A new tab will be opened. From here we will start to create our Fiori project.

« Click on New Project from Template

eNETEWNL BB Tile Configuration

Register to SAP Fiori Launchpad
General Information

*Provider Account portal (flpnwc)

*Application Name ® MyFirstFioriApp.MyFirstFioriApp.MyFirstFioriApp

Description

Intent Semantic Object Action
MyFirstFioriApp Display

More information on intent properties.

« Choose SAPUI5 Application from Template Selection
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QEWEEREE TN Basic Information

New SAPUIS5 Application
Template Selection

Search Environment Category Sort By SAPUIS Version

Q Neo v Featured v Sort by name v SAP Innovation (1.66)

Y%
7 0 7 v ¢
L ¥ ¥ ¥ (6
List Report Application SAP Fiori Master-Detail SAP Fiori Worklist SAP Fiori Worklist SAPUIS Application
Application Application Application OData V4

Creates a SAPUI project including an opticonal view. You can choose one of the following view types: XML, JSON, JavaScript, and HTML. For more information, see the
relevant Fiori Design Guidelines.

« Set your Project Name and Namespace

Template Selection Basic Information Template Customization

New SAPUIS Application
Basic Information
Project Name* MyFirstFioriApp

App Descriptor Data
MNamespace* MyFirstFioriApp

« Choose the View Type and set the View Name. In our sample we will use XML View. Click Finish and your Fiori project is created.

Template Selection Basic Information Template Customization Confirmation

New SAPUI5 Application
Template Customization

Initial View Details View Type* KML ~

View Name ScanView
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How to use cmbSDK cordova plugin

In the SAP Web IDE Workspace we can see all files that our Fiori project inludes.

File Edit Build Run  Deploy : View

Files  Project Explorer

= & @ &8
Workspace
4
MyfFirstFioriApp
. webapp
&3

controller

E| ScanView.controller.js

CSss

=l style.css
i18n

[El i18n.properties
model

El models.js
test
view

El  ScanViewview.xml
[E] Componentjs
El index.html
[Z] manifest.json
=l neo-app.json
package-lock.json
=| package.json

=l wibyaml

Open Component s file.

Componentjs is the first point of our application, we can say that it serves as index which encapsulates all our applications details, i.e. view
names, routing details, main view, applications type(Full Screen or SplitApp), application service configuration etc..

Here in init function we will configure our plugin. Set properties that we need, set callback functions, call some methods, etc..

sap.ui.define([
"sap/ui/core/UIComponent",
"sap/ui/Device",
"MyFirstFioriApp/MyFirstFioriApp/model/models"
], function (UIComponent, Device, models) {
"use strict";

var oEventBus = sap.ui.getCore().getEventBus();
var scannerIsInitialized = false;

return UIComponent.extend("MyFirstFioriApp.MyFirstFioriApp.Component", {

metadata: {
manifest: "json"

iy

9/36



COGNEX

Jx*
* The component is initialized by UI5 automatically during the startup of the app and calls the init methc
* @public
* @override
*/

init: function () {

// call the base component's init function
UIComponent.prototype.init.apply(this, arguments);

// enable routing
this.getRouter().initialize();

// set the device model
this.setModel(models.createDeviceModel(), "device");

if (!scannerIsInitialized) {
scannerIsInitialized = true;
window.readerConnected = 0;

window.scannerActive = false;

cmbScanner .addOnResume(function (result) {
cmbScanner .setAvailabilityCallback((readerAvailability) => {

if (readerAvailability === cmbScanner.CONSTANTS.AVAILABILITY_AVAILABLE) {
oEventBus.publish("ScanView", "SetConnectionStatus", {
statusText: "AVAILABLE"
1)
cmbScanner.connect((result) => {});
} else {
oEventBus.publish("Scanview", "SetConnectionStatus", {
statusText: "NOT AVAILABLE"
});

1)
if (Device.os.android) {
cmbScanner.connect((result) => {});

1

cmbScanner .addOonPause(function (result) {
if (Device.os.android) {
cmbScanner.disconnect();
}
cmbScanner.setAvailabilityCallback();
1)

cmbScanner.setPreviewContainerPositionAndSize(0, 0, 100, 50);

cmbScanner.setConnectionStateDidChangeOfReaderCallback((connectionState) => {
if (connectionState === cmbScanner.CONSTANTS.CONNECTION_STATE_CONNECTED) {
oEventBus.publish("ScanView", "SetConnectionStatus", {
statusText: "CONNECTED"
1);
if (window.readerConnected != connectionState) {
cmbScanner .setSymbologyEnabled("SYMBOL.DATAMATRIX", true);
cmbScanner.setSymbologyEnabled("SYMBOL.C128", true);
cmbScanner .sendCommand("SET TRIGGER.TYPE 2");
}
} else if (connectionState == cmbScanner.CONSTANTS.CONNECTION_STATE_DISCONNECTED) {
oEventBus.publish("Scanview", "SetConnectionStatus", {
statusText: "DISCONNECTED"
1)
} else if (connectionState == cmbScanner.CONSTANTS.CONNECTION_STATE_CONNECTING) {
oEventBus.publish("Scanview", "SetConnectionStatus", {
statusText: "CONNECTING"
1)
} else if (connectionState == cmbScanner.CONSTANTS.CONNECTION_STATE_DISCONNECTING)
oEventBus.publish("Scanview", "SetConnectionStatus", {
statusText: "DISCONNECTING"
1)

window.readerConnected = connectionState;

i

cmbScanner.setAvailabilityCallback((readerAvailability) => {
if (readerAvailability === cmbScanner.CONSTANTS.AVAILABILITY_AVAILABLE) {
oEventBus.publish("ScanView", "SetConnectionStatus", {
statusText: "AVAILABLE"
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1)
cmbScanner.connect((result) => {});
} else {
oEventBus.publish("Scanview", "SetConnectionStatus", {
statusText: "NOT AVAILABLE"

1)
1)
cmbScanner.setActiveStartScanningCallback((result) => {

if (result === true)
window.scannerActive

true;
elise
window.scannerActive = false;

i

cmbScanner.setPreviewOptions(cmbScanner.CONSTANTS.PREVIEW_OPTIONS.DEFAULTS | cmbScanner.CON
cmbScanner .setCameraMode (cmbScanner .CONSTANTS.CAMERA_MODES.NO_AIMER);

var sdkKey = "";
if (Device.os.android)

sdkKEY = this.getModel("1i18n").getProperty("MX_MOBILE_LICENSE_ANDROID");
else

sdkKEY = this.getModel("1i18n").getProperty("MX_MOBILE_LICENSE_i0S");

cmbScanner.registerSDK(sdKKEY);

cmbScanner . loadScanner (0, (result) => {
cmbScanner.connect((result) => {});

i

oEventBus.subscribe("Component", "LoadScanner", this.loadScanner, this);
}
}
loadScanner: function (sChanel, sEvent, oData) {
cmbScanner.disconnect((result) => {
cmbScanner. loadScanner (oData.selectedDevice, (result) => {
cmbScanner.connect((result) => {});

1)
1)
}!
onExit: function () {
oEventBus.unsubscribe("Component", "LoadScanner", this.loadScanner, this);
cmbScanner .disconnect();
cmbScanner.setAvailabilityCallback();
}

1)
1

cmbScanner is an object that represents our plugin. With this object we can access all APl methods and Constants from our plugin.

- scannerlslnitialized - variable to make sure that we set some functions for initialization only one time

- window.readerConnected - global variable that is changed every time when the reader connection state is changed

« window.scannerActive - global variable that shows us if scanning is active or not

« cmbScanner.addOnPause - in this method we disconnection from reader device on Android (on iOS this is handled automatically), and
stop listening to availability changing

« cmbScanner.addOnResume - in this method we try to connect with reader device again and set callback for availability changing

« cmbScanner.setPreviewContainerPositionAndSize - to set the size and position of the preview container. Learn more here.

« cmbScanner.setConnectionStateDidChangeOfReaderCallback - all connect/disconnect events should be handled within the
callback function set with this APl method. If connection state is connected we set some reader device settings with APl methods or
directly with sendCommand(), method. Here in this example we enable symbologies and set trigger type. Also here we should Licensing
the SDK. We will speak about this later in this section

« cmbScanner.setAvailabilityCallback - to monitor for availability of the MX device. If MX device is available we try to connect. Learn
more here.

« cmbScanner.setActiveStartScanningCallback - to monitor the state of the scanner. Learn more here.

« cmbScanner.loadScanner - to get a scanner up and running. Learn more here.

Here we are only configuring reader device, handling connections, availability, etc.. We will do scanning and getting results in other views. If
we want to notify users about every connection state changed or other info about reader device we will be using EventBus sap object. With
this object we can publish function and call them from any view in the application. In this example on connection state changed with EventBus
we are calling SetConnectionStatus function that is implemented in view where scanning is performed and set label text to show user current
connection state.
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Now open ScanView.view.xml and add this code:

<mvc:View controllerName="MyFirstFioriApp.MyFirstFioriApp.controller.ScanView" xmlns:mvc="sap.ui.core.mvc" displayBlock="tr
xmlns:core="sap.ui.core">
<Shell id="shell">
<App id="app">

<pages>
<Page id="page" title="{il8n>title}">
<subHeader>
<Toolbar id="__toolbar2" width="100%">
<content>
<FlexBox id="__box0" width="100%" alignContent="Center" ali
<items>
<Select id="selectActiveDevice" items="{/De
<core:Item text="{text}" key="{key]
</Select>
</items>
</FlexBox>
<Label id="1blStatus" text="DISCONNECTED" width="100%" text
</content>
</Toolbar>
</subHeader>
<content>
<FlexBox id="flexBoxContainer" width="100%" alignContent="Start" alignItems
</content>
<footer>
<Toolbar id="__toolbarl" width="100%">
<content>
<Button id="btnScan" press="btnScanPress" text="Scan" widtl
</content>
</Toolbar>
</footer>
</Page>
</pages>
</App>
</Shell>
</mvc:View>
You can design view with CodeEditor or with LayoutEditor.
webapp
controller
=l ScanView.controller js
C55
E stylecss
i18n
= i18n.propertias
model
E modelsjs
view
dl] L el
EILEY  Open With > Layout Editor
=l mani Import » Code Editor
=! _gitigno
] Export
=! _project

After that open ScanView.controller.js and add this code
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sap.ui.define([
"sap/ui/core/mvc/Controller"
], function (Controller) {
"use strict";

var oEventBus = sap.ui.getCore().getEventBus();
var oModel = new sap.ui.model.json.JSONModel();
oModel.setData({
Devices: [{
key: "o",
text: "MX Device"
o {
key: "1",
text: "Mobile Camera"
H
i

return Controller.extend("MyFirstFioriApp.MyFirstFioriApp.controller.ScanView", {
onInit: function () {
this.getView().setModel(oModel);
+

onAfterRendering: function () {

window.scannerActive = false;

switch (window.readerConnected) {

case cmbScanner.CONSTANTS.CONNECTION_STATE_CONNECTED:
this.getView().byId("lblStatus").setText("CONNECTED");
break;

case cmbScanner.CONSTANTS.CONNECTION_STATE_DISCONNECTED:
this.getView().byId("lblStatus").setText("DISCONNECTED");
break;

case cmbScanner.CONSTANTS.CONNECTION_STATE_CONNECTING:
this.getView().byId("lblStatus").setText("CONNECTING");
break;

case cmbScanner.CONSTANTS.CONNECTION_STATE_DISCONNECTING:
this.getView().byId("lblStatus").setText("DISCONNECTING");

break

default:
this.getView().byId("lblStatus").setText ("UNKNOWN");
break;

}

oEventBus.subscribe("ScanView", "SetConnectionStatus", this.setConnectionStatus, this);
cmbScanner.setResultCallback((result) => {
if(result && result.readResults && result.readResults.length > 0){
result.readResults.forEach((item, index) => {

if (item.goodRead == true) {
//Perform some action on barcode read
//example:
var verticallLayoutContainer = new sap.ui.layout.VerticalLayout(null, {
width: "100%"
}) .addStyleClass("sapUiSmallMarginTop");
verticallLayoutContainer.addContent(new sap.m.Label({
text: item.symbologyString + ":",
textAlign: "Begin"
design: "Bold"
}) .addStyleClass("sapuiSmallMarginBegin"));
verticallLayoutContainer.addContent(new sap.m.Text({
text: item.readString,
textAlign: "Begin"
}) .addStyleClass("sapuiSmallMarginBegin"));
this.getView().byId("flexBoxContainer").addItem(verticallLayoutContainer);

}
else{
//Perform some action when no barcode is read or just leave it empty
}
1),
}
1)
}

btnScanPress: function () {
if (window.readerConnected === cmbScanner.CONSTANTS.CONNECTION_STATE_CONNECTED) {
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if (window.scannerActive === true) {
cmbScanner.stopScanning();

} else {
cmbScanner.startScanning();

3
3

setConnectionStatus: function (sChanel, sEvent, oData) {
this.getView().byId("1lblStatus").setText(oData.statusText);

i
activeDeviceChanged: function () {

cmbScanner.disconnect((result) => {
oEventBus.publish("Component", "LoadScanner", {
selectedDevice: parseInt(this.getView().byId("selectActiveDevice").getSelectedKey()
3
});
}!

onExit: function () {
oEventBus.unsubscribe("Scanview", "SetConnectionStatus", this.setConnectionStatus, this);

if (window.readerConnected === cmbScanner.CONSTANTS.CONNECTION_STATE_CONNECTED) {
if (window.scannerActive === true) {
cmbScanner.stopScanning();
}
}

cmbScanner .setResultCallback((result) => {
return false;

1

1
1}

In this view we have a Scan button to startScanning()/stopScanning() and cmbScanner.setResultCallback to handle successful scan results.

Build Fiori Mobile Application

In this section we will explain how to build Fiori Mobile Application (generate .ipa and .apk files).

1. Using HAT (Hybrid Application Toolkit)

« First we need to enable HAT extension in SAP Web IDE Workspase. Open Tools->Preferences:

File  Edit Run Deploy Search View Tools Help

Quick Access

Development

Storyboard

Preferences Crl+.

: ;:_:. Preferences (Ctrl+.) . ;.:.

Workspace Manager
SAP Cloud Platform Cockpit
Ul Theme Designer

Create Data Source
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« Navigate to Extensions section and search for HAT extension:

Global Preferences

Extensions
Code Check Enable the SAP Web IDE extensions you want, save, and refresh the browser.
Code Editor
Core Data Senvices
Default Ediors HAT ® Q Al Categories v Al States v
Git Committer
Keyboard Shartcuts Lresults
Workspace Prefer
Jorkspace Preferences Workow Ebior - it g ol -
Cloud Foundry
Extensions

You can model and deploy workflows that help in
automating process steps.
More Information

You can create hybrid mobile apps using Apache
Cordova and SAP Mobile Platform SDK In SAP Web

More Information

By default HAT extension is disabled. Enable HAT extension and click Save. After enabling we will need to refresh SAP Web IDE.

Extensions
Enable the SAP Web IDE extensions you want, save, and refresh the browser,

HAT ® Q All Categories v All States v

2 resulfs

Workflow Editor OFF Hybrid App Toolkit

You can model and deploy workflows that help in
automating process steps.
More Information

You can create hybrid mobile apps using Apache
Cordova and SAP Mobile Platform SDK In SAP Web

More Information

« After enabling HAT go again in Tools->Preferences. If you have both Fiori Mobile and Mobile Services enabled you will have
options to select one that will be used as Cloud Build Service. Please choose Mobile Services and click Save:
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Global Preferences

Code Check

Code Editor

Core Data Services
Default Editors

Git Committer

Keyboard Shortcuts
Workspace Preferences

Cloud Foundry
Extensions

Hybrid Application Toolkit

If you don't see these radio buttons you don't need to do anything. Mobile Service will be enabled by default.

Hybrid Application Toolkit
Hybrid App Toolkit Settings

\

Cloud Build Senvice AP For Moble (deprecated) (®) Moble Services

Enable Local Add-on Features

The Local Add-on features have reached end-of-maintenance. The feature will continue to be available for use as
to the local add-on will not be accepted.

We recommend using the Cloud Build Service to continue building your hybrid apps with the latest versions of the

rd
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Now right click on project root and you will see Mobile section. Click Enable as Hybrid Mobile Project
A v ® < >

Files  Project Explorer

g & @ 6o
Workspace
MyFirst™-="—=
— h Run »
.che
- Build >
is
Deploy ¥
weba
BN Mobie [ Enableas Hybrid Mobile Project
cot
- Git g Select Cc Plugins
css |
= s Mew > Build Packaged
= i
: i Import y Build Developer Companion
md Export
. Edit »
tes
vid Project y
— Refresh Workspace ltems
El Co P
EI ind Quick Access Ctrl+3

« You can see that some new files are added in our project that allow us to build this project as mobile application. Before build we
need to add our cmbsdk-cordova plugin. Click on Select Cordova Plugins, find cmbsdk-cordova plugin from public plugins and
add in this project. Don't forget to click Save when you add plugin.

MyFirstF=if=-
. Run ¥
.che
. Build >
dist
Deploy >

O
F .
3
g

il
Git ; Select Cordova Plugins

= app -
=] app MNew > Build Packaged App
21 inde Import > Build Developer Companion
weba Export
— Edit >
con
s Project >
i181 Refresh Workspace ltems
=1 i Quick Access Ctrl+3

17736



COGNEX

Select Cordova Plugins
Selected (9) | Public(1) Kapsel(20)
v | cmbsck-cordova ®an
PluginID Plaforn ~ Verson  Description lastUpdated’On Agtions
"I
embsdk-cordova ".' 1214 CMB Scanner Cardova Plugh 6.Jin 2019 S ‘ 4
View Detalls
Close
Select Cordova Plugis
Selected (10) \M Kapsel (20)
v bsdkoordova Bat
PluginID Plaforn ~ Version  Descripion Last Updated On Actions
cmbsdk-cordova "" 1214 CMB Scanner Cordova Plugn 6.Jun 2019 #

-+ S Close
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« We are ready to build our mobile application and generate .ipa and .apk files. Click on Build Packaged App from Mobile menu.

MyFirstFioriApo

.che Run :
dist Build ¥
mobi___Deploy ’
Zl ap Git ’ Select Cordova Plugins
z] ap New > Build Packaged App
Zl  inc Import > Build Developer Companion
webz  Export
coi  Edit 2
cse Project ¥
i18 Refresh Workspace ltems
El i Quick Access Ctrl+3
« Set your application details
LYo Plfom
Configure Mobil Buld Settings
Aop o
Hop Name NyfFistFioridop Aop Version @
Descrpton Lindscape Splash i
ln i Potat pes i
19200 X 1520 2048ox X 1536x 153600K 2048px
s
o ;
o I
Previos Next

« Choose platform or both iOS and Android platforms, select signing profiles (or create one if you don't have) and set some

common options
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Rpplnfo Push Notfcaton

Configure Mobile Build Settings

Platom
Dy | 7 el
Signing Frofle 1035apAopDev v Sining Profle AncidSapAppDav v
Minmum 05 Verson ik v Hiimum 05 Vesion ) i v
Common Options
Buld bugeebled biaes ()
V Disableprvaty scree&@
Save Ycode and or ndroid Studo pofcts @
Packaged SAPUIS Version 1641 v
Previous Nex
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« Start building process

App Info | Platform ' Push Notificaﬂon

Configure Mobile Build Settings
Confirmation

Click the Build button to save the app settings and start building the project.

When the build finishes, a result dialog will show. If the build succeeds, you will be able to download and install the app on your device.

Previous Build
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« When building process is finished popup from where you can download .ipa and .apk files will be shown
The MyFirstFioriApp Packaged App Build Results

Android i05

Scan the QR code to install the MyFirstFioriApp app v1.0 on your device

Alternatively install the file from your PC to Android emulator or device via ADB

MyFirstFioriApp.apk

Close

2. Using Fiori Mobile Service

Before we start to build our Fiori Mobile Application with Fiori Mobile Service we need to deploy our project on SAP HANA Cloud

Platform.
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Right click on project folder then select Deploy and choose Deploy to SAP Cloud Platform
File Edit Build Run Deploy Search View Tools Help

A I = L
llil ndl| ._J b4 @ <
Files  Project Explorer
R W
f 96 ® o
‘}"J Workspace
MyFirstFioriApp
— Run g
. webapp
oS Build ;

controller

B Scanvie Deploy > Push Down Annotations (Beta)

css Git g Deploy to SAPUI5 ABAP Repository
A stylecss New s Deploy to SAP Cloud Platform

i18n Import eSO AP oy to SAP Cloud Pltform |
B il8npro Export Application Status

model Edit ’
El models] Project ’

test Refresh Workspace ltems

view Quick Access Ctrl+3
L) I SR R S — |

« Set application details and click Deploy

Deploy Application to SAP Cloud Platform

A build will be triggered for the project. The build results will be deployed.

Application Details

#) Deploy a new application Update an existing application

*Account - Get Accounts

Project Name MyFirstFioriApp

*Application Name myfirstfioriapp

Version Management

*Version 1.0.0 | Activate

Deploy | | Cancel
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« After a successful deploy, the next step is to Register to SAP Fiori launchpad that we've created in the previous section.

Successfully Deployed

Wersion 1.0.0 has been created.
Open the active version of the application

Open the application's page in the SAP Cloud Platform cockpit

You can now register the application to SAP Fiori launchpad.

. Register to SAP Fiori launchpad | | Close

« Choose account and set application name

NN (il Tile Configuration

Register to SAP Fiori Launchpad
General Information

*Provider Account portal (flpnwc)

*Application Name ® MyFirstFioriApp.MyFirstFioriApp.MyFirstFioriApp

Description

Inent Semantic Object Action
MyFirstFioriApp Display

More information on intent properties.

« Set Type (Static by default), set Title, and Subtitle
General Information  SEEERSGIi=0IEN I Assignment

Register to SAP Fiori Launchpad
Tile Configuration

*Type Static

*Title cmbSDK Fiori App
Subtitle Sample

lcon sap-icon://approvals

24/ 36



COGNEX

« Choose Site that we create before, catalog, and group (sample catalog and group is created by default)

General Information | Tile Configuration EREERIGELIEE Confirmation

Register to SAP Fiori Launchpad

Assignment

*Site cmb5DKTestSite
*Catalog Sample Catalog
*Group Sample Group

« Click finish on Confirmation tab and if everything is fine the popup below will be shown. Click OK to close this popup. With these
steps we deploy our project on HCP and now we can continue to build our Fiori Mobile Application

Successfully Registered X

The application was successfully registered to SAP Fiori [aunchpad.
Open the registered application
Open SAP Fiori launchpad

OK

« Go to Services tab again, open Fiori Mobile service, and click on Go to Admin Console
3 Service: SAP Fiori Mobile - Overview

Service Description
The mobile service for SAP Fiori is an end-to-end solution designed to ¢
mobile users. Use the build/packaging service to transform web conten

manage the app lifecycle, runtime services to support enterprise app s¢
services to provide insights into adoption, usage, and app performance

Take Action

Configure Fiori Mobile

Configure Mobile Packager
-—

Go to Admin Console

Go to Mobile Place
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« Open Manage Plugins section and upload cmbsdk-cordova plugin as custom plugin. You can download latest plugin on this link.

Add Custom Plugin

Select any one

Source File (mb3DK_Cordova_v21.3.12014.2ip Browse...

[0 Please refer to fhe "Vanaging Custom Plugins" section n our help quide fo know more
about the plugin specificafion thatis supported.

0K Cancel

Next manage your singing profiles. Open Manage Signing Profiles section and create new ones if you don't have already

Manage Signing Profiles
[ Platforms 4 Proflles
Manage Apps
Approte Apps Al / & / &
Manage Plugins . l" ' l"
oA Android
Configure App Discovery 105SapAp... AndroidSa . NAT
Manage Signing Profiles o
Uploaded By Generated By Uploaded By Generated By
& Users I [ [ L
& Account Eipiry Date Expiry Date Expired On Expiry Date
May 21, 2020 Jun 16, 2044 May 11, 2018 Octb, 2042

26/ 36


https://cmbdn.cognex.com/files/download_latest/cmbSDK_Cordova

COGNEX

oy Home

Now open Manage Apps section and create New Application

Manage Apps
~

Analytics
-+ mMew Application | | 4~ Categories

Applications
Manage Apps

Approve Apps

Manage Plugins

Configure App Discovery
Manage Signing Profiles

Users

= Account

Select first option
Apps home | Add new application

What's Your Fiori App Scenario?

Tell us about the number of Fiori apps you want to put into a single binary

@) Iwant to create a local launchpad with only the 2pps | want to mobiize.

Choose this if you want to create a custom, local launchpad with muttiple: Fior applications. We'll download the Ul for the apps into the binary
when we build it, so its there when the app launches. You'll need Fiori 1.30+ compliant applications and be running ne Fiori Server Ul Add-on

20.

I'want to mobiize an existing launchpad or Fiori application.

Choose fhis if you have a single Fiori URL you want to mobiize, or if you are not running the Fiori Server Ul Add-on 2.0.

Previous

Next

Cancel
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« Select your Fiori Cloud Edition as Fiori Server

Apps home | Add new application

Select Your Fiori Server

Fiori Server Name Virtual Host with URL

roicoucedion [N Ayailzble
Gl [ Avaiizble

Previous Next Cancel
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« Select application that we created before (with double click or drag&drop)

Apps home | Add new application

Define your Fiori Application

#) Select from available Fiori Appications
Available Applications Selected Applications i

S tmb30K Fiori App: MyFirstFiaridpp MyFirstFioriApp

Upload advanced configuration fll

Previous Cancel

« Set you application name and signing profiles. At the bottom of page you have question "Are you ready to build the application ?".
Select "No, | would like to customize my application".
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Build Your Fiori Application

1520 X 1520

*Application Name
mwy ¥
- cmbSOK Sample App

Uplo...

Connection Security

Users will be suthenticated with SAML each time the application is used.

Build Opticns
«| oS Signing Profile: IOSSananpDey ~ Minimum OS Version:
« | Android Signing Profile: AndroidSapAppDey Minimum OS Version:

Enable Android and/or i05S project(s) download after build
Enable verbose logging

Build debug-enabled binaries

10 w

50 -

Mote: If you would like to debug your Android application with Chrome andfor your i05 application with Safari, enable this option. For Android, your
application will be sutomatically signed with an internal debug signing profile. For i05, select 8 developer signing profile to sign your application

to enable you to debug.

For iQS, an i0S signing profile must be selected to enable the build option.

Cached Content

Clear cached content prior to initiating build

Mote: SAP caches the SAPUIS runtime referenced by your application in order to reduce build time. If you believe this content may have been

updated since the last time an application was built referencing this SAP Fiori front-end server, enable this option.

Multimedia

Splash Soeen - Portrait Splash Soreen - Landscape

15360 X 20480
204500 X 15360

Uplocad Upload

Are you ready to build the application?

- v/

® Mo, | would like to customize my application

Frevious MNext Cancel

Window where we can continue with app customization will be opened. From here we will add plugin that we uploaded before
and disable passcode screen. You can set some others parameters per your needs. Also important thing here is to save every

change that will be made.
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We are ready to build our mobile application and generate .ipa and .apk files. Navigate to Platforms and click Build All button if
you want to build both iOS and Android platform together, or you can build one by one from Actions grid column.
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Ayps one | enbSOK Sampe App

/M 7\ N N\ A A A /
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Build popup will be shown. Click Build button and wait while building process finish.
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Build Summary
Application Information
Application Name: emhSDK Sample App
Build Options
Signing Profie:  i05SapppDe v Minimum O Version: 110
Signing Profile  AndroidSapAppDev v Minimum OS Version: 5.0

Enable Android and/or i0S project(s) download afier build
Enable verbose logging

Build debug-enabled binaries

Note: If you would lie to debug your Android appiication with Chrome and/or your 10 appication with Safari, enable ihis option. For Android, your
applcation will be automaficaly signed with an intemal debug signing profile. For 10, select a developer signing profie to sign your application to enable

you to debug.

Fori03, an 03 signing profile must be selected to enable the buid option.

Cached Content

Clear cached content prior to initiating build

Note: SAP caches the SAPUIS runfime referenced by your application in order to reduce build time. If you believe this content may have been updated

since the fast time an application was buit referencing fhis SAP Fiori front-end server, enable this option.

Email Nofification

Send me an email noffication when my applications are buif

Build  Cancel
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« When building process is finished you can download binary (.ipa or .apk) file and install application on your mobile device

Appshone | cmbSOK Sampl App

a a N ' ' ' N A
B oy (B (B >y (@ 2 (2] (B @ y @ (&
\_/ \_/ \/ \/ \/ \/ \_/

g Dials Gnupe

Sae Debug Enabled

Je—

New
Sined

Je—

New
Sined

Ready b bld

Rea

i it Yourapplaton s ready o b but

Licensing the SDK

If you plan to use the cmbSDK to do mobile scanning with a smartphone or a tablet (without the MX mobile terminal), the SDK requires the
installation of a license key. Without a license key, the SDK will still operate, although scanned results will be blurred (the SDK will randomly

I tmeda

Operatng System

ANDROD

ANDRAD

gig

AopSet

Fom Factor

TebltPhore

TebliPhore

TebliPhore

TabltPhone

s

replace characters in the scan result with an asterisk character).

Contact your Cognex Sales Representative for information on how to obtain a license key including trial licenses which can be used for 30

days to evaluate the SDK.

After obtaining your license key open i18n.properties file in your project on SAP WEB IDE service, and set your obtained keys.

Files  Project Explorer

Workspace
MyFirstFioriApp
.che

Ccss
i18n
[El i18n.properties
model

"/
Flafyms Caeges Onnerny / Eil

l/ dnAp

Aop erson Rt On Cetfca s

3 Lot vy

10 e 219 1
I.l Selto il
[y
10 8 219 im0 I:I-) Sl ]

£ @ 88

Then go back to the Component.js file and check this code:

il8n.properties x

1

[ N TV =]

title=Title
appTitle=MyFirstFiorifpp
appDescription=App Description

MX_MOBILE_LICENSE_ANDROID=Android_Key
MX_MOBILE_LICENSE_i0S=1i05_Key
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var sdkKEY = "";
if (Device.os.android)

sdkKEY = this.getModel("i18n").getProperty("MX_MOBILE_LICENSE_ANDROID");
else

sdkKEY = this.getModel("i18n").getProperty("MX_MOBILE_LICENSE_i0S");

cmbScanner .registerSDK(sdkKEY) ;

You can see that you read this key from i18n.properties and call cmbScanner.registerSDK method to register SDK with your license key.
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